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PART-IIB
THE HIGH COURT OF MEGHALAYA

SHILLONG

NOTIFICATION
The 15t"March, 2024.

No.HCM.11/8/2024/Comp/679.

THE HIGH COURT OF MEGHALAYA ONLINE ELECTRONIC
(E-FILING) RULES, 2024

Preface

Whereas it is necessary and expedient to enable and regulate the electronic filing (e-Filing) procedure in the
High Court of Meghalaya, subordinate courts and tribunals under the supervision of the High Court of
Meghalaya; and

In exercise of the powers under Article 225 and 227(2)(b) of the Constitution of India, the High Court of

Meghalaya makes the following Rules.

1. Short Title, Applicability and Commencement:

1.1. These Rules shall be called the High Court of Meghalaya Online Electronic (e-Filing) Rules,
2024.

1.2. These Rules shall apply to the High Court of Meghalaya and to the subordinate courts and
tribunals under the supervision of the High Court of Meghalaya.

1.3. These Rules shall be applicable to such categories of cases as may be notified by the Chief
Justice of the High Court of Meghalaya from time to time.

1.4. These Rules shall apply to online e-Filing and e-Filing through Designated Counters and
facilities provided for e-Filing including e-Service Counter.

1.5. These Rules shall come into force from the date notified by the High Court in this behalf.
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Action: includes all proceedings instituted in the Court such as suits, criminal complaints, appeals,
review, revision, civil or criminal writ petitions, revision petitions, contempt petitions, execution
petitions, arbitration petitions, probate cases and interlocutory applications.

Administrator: means the Registrar (IT) or an officer appointed by the Chief Justice and includes an
officer appointed by the District Judge/Chairman or President of tribunals, as the case may be, for
administering and dealing with matters connected with or relating to e-Filing.

Bench: means and includes one or more Judges assigned to adjudicate upon Actions or the
presiding officer of the Court or Tribunal as the case may be.

Physical Filing: means Actions and pleadings filed as hard copies.

Designated Counters: means and includes those counters as mentioned in Appendix-I.

District Courts: means and includes the courts established and functioning under the control and
supervision of the High Court.

Electronic Filing (e-filing): means e-filing as prescribed through the Internet (at the web portal of the
Court) and through the internet/intranet at Designated Counters, unless the context requires
otherwise.

Evidence: means and includes evidence as defined under the Indian Evidence Act, 1872.

High Court: High Court means the High Court of Meghalaya.

Objections: means and includes deficiencies and errors pointed out by the Registry in relation to the
Actions instituted in the Court.

Opposite Party: means defendant(s), respondents, judgment debtor(s) and non-applicant(s).

Party: means appellant(s), plaintiff(s), petitioner(s), complainant(s) and applicant(s).

Pleadings: means pleadings filed in support or defence of an Action including affidavits, additional
affidavits and supplementary affidavits.

PDF: means an electronic document filed in a portable document format.

PDF/A: means an ISO-standardized version of the Portable Document Format (PDF) specialized for
the digital preservation of electronic documents.

Registry: means the Registry of the Court.

Statement of Defence: means and includes written statements, replies, counter affidavits and
additional or supplementary affidavits.

Technical failure: means a failure of the court's hardware, software, and/or telecommunications
facility which results in the impossibility of submitting a file electronically. Technical failure does not
include malfunctioning of the equipment of the person submitting an e-file.

Third Party: means and includes any person or entity seeking to become a party or to intervene in
an Action.

Working Day: means and includes a day when the Registry of the Court is working under the
Calendar published or as directed by the Court.
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2. General Instructions

4,

3.1

3.2

3.3

3.4

On-line e-filing shall be made by visiting the web portal of the Court,
namely:https://filing.ecourts.qov.in/pdedev/

Except as provided in these Rules, Actions, whether in fresh, pending or disposed of cases, will be
filed electronically by an advocate or litigant in person from their home, office or other remote
location in the manner provided in these Rules.

Any person who is unable to access the e-filing portal would be entitled to make use of the facilities
provided at the Designated Counters for that purpose upon payment of charges if stipulated by the
High Court.

The size of the e-file should not exceed 20 MB. In case the file size exceeds 20 MB, it can be split

up and uploaded separately.

Steps for Registration

4.1

4.2

4.3

4.4
4.4.1

Persons other than Advocates and litigants in person who are already registered on the Court web
portal will take the following steps to register themselves.
Advocates

a) Should visit the web portal (https./filing.ecourts.gov.in/pdedev/) to view the form.

b) Click the registration link.
c) Fill the form with requisite details.
d) Submit the filled-up form along with a self-attested copy of the Bar Council Registration
Certificate or Bar Council I-card (in PDF format only).
Litigants in person
a) Should visit the web portal (https./filing.ecourts.gov.in/pdedev/) to view the form.

b) Click the registration link.

c) Fill the form with requisite details.

d) Submit the filled-up form along with the self-attested copy of any identity document issued

by the Government (in PDF format only).
Litigants in person shall submit an affidavit/undertaking that they have not engaged an Advocate in
the Action. A litigant in person who subsequently engages an Advocate, shall make an application
before the Administrator for transferring the data in respect of the Action to the Advocate’s account.
Once the Administrator allows the application, the data in the Action shall be transferred in the user
account of the Advocate. The litigant in person will not be in a position to modify the data of the
subject Action, without the permission of the Administrator.
A'login ID will be allotted on the next working day if the application is found complete in all respects.
The procedure for registration is set out in Appendix-II.
Responsibilities of the Registered User:
It shall be the responsibility of the registered user to have a valid and working email address to
receive notification from e-Filing portal electronically. It will not be the responsibility of Court to

ascertain whether a registered user is receiving notifications from the e-Filing system via email.
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4.4.2 If the register user’s email address, phone number or other information provided on e-Filing portal
has changed, the registered user must make the necessary changes to his/her profile.
4.4.3 A registered user shall be liable for:

a. Any conduct using his/her user ID;

b. The conduct of any person to whom access is provided by sharing his/her user ID and
password;

C. Any inappropriate conduct may result in suspension of the account or other process in as may
be initiated under the law for the time being for contempt of court, or commission of an
offence under relevant laws in force at the time of the inappropriate conduct. It shall be
presumed that the document(s) has /have been filed by the person using the user ID.

4.4.4 1t shall be the responsibility of the register user to maintain the secrecy of his/her user id and
password. If a registered user believes that the security of his/her electronic identity has been
compromised or that a threat to the system exists, the registered user must intimate the Registry of

the High Court of Meghalaya.

Frame of Pleadings

The pleadings should be clear and concise. Parties and third parties should set forth their
claims/averments in separate paragraphs. The statement of truth/ affidavit of the concerned person must
bear their signature. Opposite parties should also file their replies under sequentially numbered

paragraphs and headings (such as Preliminary Objections and Objections on Merits).

Formatting
6.1 All the original typed text material including notice of motion, memorandum of parties, main petition
or appeal, interlocutory application(s), reply, status report, affidavit, documents, will be prepared
electronically using the following formatting style:
o Papersize: A-4
e Top Margin: 1.5”
¢ Bottom Margin : 1.5”
e Left Margin: 1.75”
¢ Right Margin : 1.0”
e Alignment : Justified
e Font: Times New Roman
e Fontsize: 14
e Line spacing: 1.5
o If any document is typed in a local language in Trial Courts, it must be prepared using xxx
Unicode Font 14.
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6.2

6.3

The document should be converted into Optical Character Recognition (OCR) searchable Portable
Document Format (PDF) or PDF/A using any PDF converter or inbuilt PDF conversion plug-in
provided in the software. PDF/A is the preferred format.

A document which is not a text document and has to be enclosed with the Action, should be
scanned using an image resolution of 300 DPI (Dots per inch) in OCR searchable mode and saved
as a PDF document. The procedure for converting a document into an OCR searchable PDF as

mentioned above and as required in clause 8.1 is set out in Appendix — lIl.

Digital Signatures

7.1

7.2

7.3

The PDF document shall be digitally signed either by the parties and/or by their Advocate. The
digital signatures shall be appended on such places on the PDF document as prescribed under the
extant rules. If neither the party nor the Advocate who has been engaged possess a digital
signature, a print out of the Action shall be physically signed by the party concerned and/or their
Advocate in accordance with rules and it shall thereafter be scanned and uploaded.

A List of recognized Digital Signature Providers and the procedure involved in appending single or
multiple signatures is set out in Appendix — IV.

A litigant in person or advocate who does not possess a digital signature issued by the competent

authority can authenticate e-filed documents by e-Sign based on Aadhaar authentication.

Do’s and Don’t’s

8.1

8.2

8.3

8.4

8.5
8.6

The text documents and scanned documents set out in clauses 6.3 and 7.1 should be merged as a
single OCR searchable PDF file and should be book-marked as per the Master Index, duly
approved by the Registry. The procedure in this behalf is set out in Appendix -V.

The merged documents should be uploaded at the time of on-line e-filing.

Screenshots of the manner of accessing the on-line e-filing portal and for the filing of the main case
and documents including written statements, replies, replications, rejoinders, affidavits and
evidence in a pending case are set out in Appendix - I.

Once e-filing is accepted, the filing or registration number shall be notified to the Advocate or litigant
in person.

In case on-line e-filing includes audio and/or video files, the Administrator shall generate a hash
value.

Special Characters are not allowed while e-filling Memo of Parties and Advocate remarks.
Document Binary File Name Standards

The following special characters are not allowed in a file name:

e A quotation mark (")

e A number sign/Pound (#)

o Percent (%)

e Ampersand (&)

o Asterisk (*)
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e Colon (:)

e Angle brackets (less than, greater than) (<>)

e A question mark (?)

e Backslash (\)

e Forward slash (/)

e Braces (left and right) ({ })

» Pipe(])

e Atilde (~)

e The period (.) character used consecutively in the middle of the file name or at the beginning or
end of the file name.

File names should not exceed 45 characters in length, including spaces. Single space must be

counted as one character each.

8.7. On-line e-filing shall not be watermarked or encrypted. The e-filed documents shall not contain any
virus, malware, spam-ware, trojan horse or the like. All the efiled documents shall be legible and
free of markings, track changes or annotations.

9. Payment of Court Fees/Other Charges
Court fee and other charges can be paid either electronically by purchase on the online facility at ePay

portal https.//pay.ecourts.qov.in/epay/ or from the Designated Counters provided for the purpose in the
High Court and District Courts or from any authorized court fee vendor. The Transaction ID provided upon
payment of court fee and other charges is required to be entered in the appropriate field at the time of on-

line e-filing.

10. Retention and Filing of Originals

10.1 Originals of the documents that are scanned and digitally signed by the Advocate or the litigant in
person at the time of e-filing, the signed vakalatnama, signed and notarized/attested affidavit should be
preserved, for production or inspection, and the same shall be filed in the Registry of the High Court or
in the Filing Section of the District Judiciary as the case may be within seven working days of online
Registration through the web portal.

10.2 The signed vakalatnama, signed and notarized/attested affidavit and any other document whose
authenticity is likely to be questioned should be preserved, at least, for two years or till after the final
disposal of the Action. Final disposal shall include disposal of the Action by the superior appellate court.

10.3 If the authority of any document relied by the party is likely to be questioned, such document shall be
filed in the Registry or before the authorised person.

10.4 Notwithstanding anything above, the following documents will have to be preserved permanently:-

a. A Negotiable Instrument (other than a cheque) as defined in Section 13 of The Negotiable
Instruments Act, 1881 (26 of 1881).

b. A Power-of-Attorney as defined in section 1A of the Powers-of-Attorney Act, 1882 (7 of 1882).

c. A Trust as defined in Section 3 of The Indian Trusts Act, 1882 (2 of 1882).
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10.5

11.

12.

13.

14.

14.1

14.2

14.3

d. A Will as defined in Clause (h) of Section 2 of The Indian Succession Act,1925 (39 of 1925)
including any other testamentary disposition by whatever name called.
e. Any contract for the sale or conveyance of immovable property or any interest in such property.
f. Any other document as may be directed by the Bench.
The responsibility of producing the originals and proving their genuineness shall be of the party that has
electronically filed scanned copies of the document.
Access to the Electronic Data of the Action
Access free of cost access will be available to authorized person(s) to data e-filed by any of the parties
to the specific Action, as is presently being provided in pending Actions. This facility shall be in addition
to the procedure of obtaining certified copies.
Exemption from e-filing
Exemption from on-line e-filing of the entire pleading or a part of the pleadings and/or documents may
be permitted by the Bench upon an application being made for that purpose in the following
circumstances:
where on-line e-filing is for reasons set out in the application not feasible; or
where there are concerns about confidentiality and protection of privacy; or
where the document cannot be scanned or filed electronically because of its size, shape or
condition; or
where the on-line e-filing portal is either inaccessible or not available for some reason; and/or
for a just and sufficient cause.
Service of Electronic Documents
In addition to the prescribed mode of service, notices, documents, pleadings that are filed electronically
may also be served through the designated e-mail IDs of Registry officials to the e-mail address of the
advocates or parties, if available. E-mail IDs of Registry officials will be published on the Court website
to enable the recipients to verify the source of the e-mail.
Computation of Time
Wherever limitation/time limits apply, it will be the responsibility of the party concerned to ensure that
the filing is carried out well before the cut-off date and time. The date of e-filing will be taken as that date
when the Action is electronically received in the Registry within the prescribed time on any working day.
For computing the time at which e-filing is made, Indian Standard Time (IST) will apply.
E-filing through Designated Counters will be permissible up to 1600 hours on any court working day.
On-line e-filing carried out after working hours or on any day which is declared as a gazetted holidays or
on a day when the court is closed, will be regarded as having been filed on the next working day. For
the computation of limitation, on-line e-filing shall be subject to the same legal regime as applicable to
physical filing, save and except as provided herein above. No exemption from limitation shall be
permitted on the ground of a failure of the web based online e-Filing facility.
The facility for on-line e-filing through the web portal shall be available during all twenty four hours of

each day, subject to breakdown, server downtime, system maintenance or such other exigencies.
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14.4

15.

16.

17.

18.

18.1.

18.2.

18.3.

18.4.

Where on-line e-filing is not possible for any of the reasons set out above, parties can either approach
the Designated Counters for e-Filing between 10:00 hours to 16:00 hours on court working days or take
recourse to physical filing. No exemption from limitation shall be permitted on the ground of a failure of
the web based on-line e-filing facility.

Provisions for limitation governing on-line e-filing will be the same as those applicable to physical filing.
The period of limitation for such actions will commence from the date when e-filing is made as per the
procedure prescribed in these Rules.

Procedure for Filing Caveat

All caveats can be filed on-line. The procedure for this purpose is set out in

Appendix-VI.

Hard Copies of Pleadings and Documents filed Electronically
Advocates, as well as parties, may print hard copies of all pleadings and documents filed electronically
for their use in the court or elsewhere. The Registry will wherever required prepare hard copies for official

use.

Storage and Retrieval of e-Filed Documents and Pleadings

E-filings will be stored on an exclusive server maintained under the control and directions of the Court.
Each such filing will be separately labelled and encrypted to facilitate easy identification and retrieval.
The security of such filings will be ensured. Access to e-filings would be restricted in the manner
provided herein above and as may be notified from time to time. For continuity of operations in case of
disaster, natural calamity or breakdown, a mirror image of e-filings available on the servers located in the

Court may be maintained at different geographical locations, as decided from time to time by the Court.

Residuary provisions
The e-filing made by an Advocate/litigant in person will be rejected if they do not follow the protocol
mandated by these Rules or practice directions.
Subject to such further directions as may be issued, it would not be obligatory on the part of the
opposite party to accept pleadings and documents by email. In such an eventuality, hard copies of
pleadings and documents will have to be provided to the opposite party. In such circumstances, the
plaintiff/ petitioner can be called upon to deposit the charges calculated on the basis of the number of
pages per defendant/respondent which are required to be photocopied. This facility will be provided
by the Registry on a written request being made by the defendant(s)/respondent(s).
The Registry will communicate the objections, if any, regarding the cases filed by email/SMS/web
hosting to the concerned Advocate/litigant in person. After the objections are cleared the case will be
processed for listing and the Advocate/litigant in person will be informed including by email/SMS.
The Chief Justice shall have the power to notify the charges payable for the facilities provided
through the designated centers.
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19. General Caution
Email is not a secure medium of communication. Any communication transmitted by email can be
intercepted or read by a third party. An Advocate or litigant in person seeking to transmit confidential or
sensitive document/material, shall approach the Registry for requisite assistance/advice.

Appendices

APPENDIX — | Screenshots showing the procedure for accessing the on-line portal, electronic filing of

documents and list of Designated Counters.

APPENDIX — Il Screenshots showing the procedure for registration.

APPENDIX — Il Screenshots showing the procedure for converting a document into an OCR searchable PDF.

APPENDIX — IV Screenshots showing the procedure for appending single or multiple digital signatures.

APPENDIX — V Screenshots showing the procedure for book-marking.

APPENDIX — VI Screenshots showing the procedure for filing Caveat.
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Appendix-Ill
CONVERT A DOCUMENT TO A SEARCHABLE PDF

A. To create a PDF/A document using Microsoft Word 2013 and above:
i. Click File and select Save As.

B Couner Mew

Paste
= % Farmat Painter

B I U -

Clipboaid

ii. Choose the correct file folder you want the document to be saved in and then click on the
dropdown arrow under “Save as type:” and select .PDF from dropdown menu.

File name: | TEST DOCUMENT SEARCHABLE PDF
Save as type: Word Document @

iii. Click the Options button.

File name: | TEST DOCUMENT SEARCHABLE PDF

Save as type- ~
Authors: Tags: Add atag

Optimize for: (@ Standard (publishing Q Optio@
onhine and printing) —.

O Minimum size [] Open file after publishing
- (publishing online)

= Folders Tools - I Save Cancel

iv. In the Options window select the check box for Document structure tags for accessibility and
ISO 19005-1 Compliant (PDF/A).

Options » HEM |

Page range
- ANl
) Current page
Selection
) Page(s) From: 1 = To
Publish what
(®) Document
Document showing markup
Include non-printing information
Create bookmarks using
® Headings
Word bookmarks
~

tigs
(gj Document structure tags fo@

PDF options

litmap text when {3 = - be embedded
Encrypt the document with a password

[
|
L

oK i Cancel
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V. Click OK to return to the Save As window.

vi. Click the Save button to save the file in PDF/A format.

B. To create a PDF/A document using Adobe Acrobat for Mac:

i. Click File and select Print.
ii. Click and hold the PDF button on the bottom left of the window until a menu appears.
iii. Select Save as Adobe PDF. A“Save as Adobe PDF” pop-up box will appear.

iv. From the “Adobe PDF Settings” drop down menu, choose PDF/A, PDF/A-1b-2005 (CMYK), or PDF/A-
1b-2005 (RGB). Depending on your version of Acrobat, these options may vary slightly. As long as your
choice has the PDF/A in it, you should be okay.

v. Click the Continue button.

vi. Save the document.

Note: If you just hit PDF in the Print Menu or choose Save as PDF, your PDF will be created using Apple’s
PDF generator which does not include a PDF/A option.

C. To create a PDF/A document using LibreOffice Writer in Ubuntu:

i. In Writer click File from the menu and select Export as PDF.

File Edit View e Styles ools Window Help
Pew - {
- & ) - - - =Y L
QO pen
D pen Remotbte File. ..

Recent Documents

ards

Templates

ave Lo Remole Server

Preview in ‘y’u‘q-h Browser
Print Preview
Print

Printer Settings...
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ii. Inthe PDF Options dialog box, make sure the Archive PDF/A-1a (ISO 1900S-1)and the Export
bookmarks boxes are selected

Conierdl  nitial View Uaer nterface Links Secarity Dégibad Signatures

Range Genaral
@ Al

Pkl B Aurchive POIFAA-Ta (O 19005%-1)

Lrleciinn

mageon
Loasirss conmnpreiskom
@ FPEC compression - L = Thaddd 1
Cinaality T, - B Eoport Godokrmarks

Expart placehcrichess
B Areduce image resolution IO DR - e s

B il DT LR

AL s 3
E ot Sultamat eaily inserted Elank pages

Lign il waterrmaTs
Vi PO alftey esport

Haelps .I.m Caneel
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CONVERT A PDF IMAGE WITH TEXT TO A SEARCHABLE PDF

There are free and trail software available that can be used to convert a PDF document especially a PDF image
document to OCR searchable PDF and one such software is PDF-XChange Viewer. Install the software and
select free option during installation.

Procedure to converting a PDF image file with text to searchable PDF file.

i Open PDF-XChange Viewer and select File from the main menu, then select Open and browse for
the PDF image file with text.
/= POF-KChange Viewer
[Fie] egit View Document Comments Took Window Help
€ Open.. ok k3 0 = My -

| W ds i Tfogmin = e 100%
‘_.'e Cipen from URL...
! .._' Save Cirl=S
b Save b, Chrls Shifts5
b=l Save Copy As-.

MNew Document... d

Pl R L e

Connecting the Ro
This i Wi Sewstibacs s b gomsrery | ol Fadisrt sinl hosd L s e 18ies gl &

What's in the Box?

The proshuct puchoage sl comtais fhe Do ng Srme
4+ Tt itk Feutdd

+ A AL peraer sdapme | vt by depam)

oA ke I eherrart cabls

ma Focogran Te ) o Pages aeeg G R
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i In the OCR pages window select the Page Range, Recognition and Output, click OK and
save the document to convert.

OCR Pages =
Page Range
9 ER O Al

dedected Pages
) Current Page
i Pages: (total 28 pages)

Type page numbers and/or page ranges separated by commas counting frem the
start af the decument. For example, type 1, 3, 5-12

Summarny: 28 selected of 28 pages

Recognition
Primary Language: English = More Languages...
Accuracy: Medium
Dutput
PDF Qutput Type: Canvert Page Content ta Image anly - Add Text Az a Layer

Images Cuality: 300 = dpi

- Sl
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Appendix — IV

List of licenced CA s available at https://cca.gov.in/licensed ca.html

Screenshots showing the procedure for appending single or multiple digital signatures.

A signer can use digital signature certificate to sign PDF with a digital signature.

Follow the steps given below to easily sign a PDF using Adobe Acrobat Reader:

Step 1: Insert the provided USB crypto token to add the digital signature certificate to the device.

Step 2: Open the saved PDF document you want to digitally sign. Go to the ‘Tools’ option from the menu, go to the

certificates option and click on the ‘open’ button.

B dcke Acrchat Reader DC (54-52) - 6 X

Fle Edt View Sign Window Helg

Tools Try Acrobat Pro DC @) Sign In

| Show Mere

Step 3: Now, a toolbar appears on the page with the options: digitally sign, timestamp, and validate all signatures.
Click on ‘digitally sign’. Now you will be prompted to select the area to insert the digital signature. Select the

preferred area with the cursor.
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- -
Home Tools  newdec2022:01-. X ® A signin
B ®dBQ OO0 v OO - KR T BLZ&DEQ 4 B0
Icenmulg D Dty sign [ Time Stamp (g vissdate Al Signatures
=]
ey
This sigruature ek requires 4 gl sigauture identty.
Would you Be to configure one now? H]
&
|t oo | | Cee L
»
0
/A
(&

— 8%l <

Step 4: You will see a pop-up window under the name ‘sign with a digital ID’. This window shows the available

digital signature certificate on your device. Select the digital signature certificate. Click on ‘continue’.

Step 5: Now you will see your digital signature appears on the screen. You can now customize the signature

according to your needs. Click on the ‘sign’ button.

Step 6: You will be prompted to save the file. Select the file name and click on the ‘save’ button. After saving you

will have to enter the DSC user pin and click on ‘log in’. The digital signature appears on the PDF document.



PART-IIB] THE GAZETTE OF MEGHALAYA, APRIL 4, 2024 58

Appendix-V

Example 1: Converting a table of contents created with Microsoft Word 2007 and creating bookmarks for
Adobe Reader 9 and Acrobat 9 Pro

This example is shown with Microsoft Word and Adobe Acrobat Pro. There are other software tools that perform
similar functions.

1. Create a table of contents at the beginning of the Word document.

r

D"! \ o ) A& s Testing-Mi
3)
- Home Insert Page Layout References
= [JeAdd Text ~ _;jInsert Endnote
= ) Update Table AB Next Footnote ~
Table of Insert
Contents ~ Footnote =) Show Notes C
Table of Contents Footnotes ]

Figure 1 Reference tab on Word ribbon, showing Table of Contents tool.
2. Use Save as... > Adobe PDF to convert the Word document to PDF, specifying both of the following:
o Enable Accessibility and Reflow with Tagged Adobe PDF
o Convert Word Headings into Bookmarks
The table-of-contents entries in the converted document will be linked to the headings in the document.

In addition, the headings will appear as PDF Bookmarks in the left-hand Navigation pane.

| Header Two for List

X Th - Contents
_"H_E‘,der ree Text HBBEE DI et e et ettt ettt et et e
Header Four
o Header Two for List... . . . . . 2

=[] Another Header One
] Another Header Two for List

LT T VOO

Another Header One

R R R

Another Header Two for LISt

Figure 2 PDF document showing the Table of Contents and Bookmarks created from the headings in a Word
document.

If the document provides a glossary and/or index, these sections should have headings that appear in the table of
contents (and thus as bookmarks in the Navigation pane). The table of contents also should be marked up with a
heading so it is bookmarked as well.



PART-IIB] THE GAZETTE OF MEGHALAYA, APRIL 4, 2024 59

If this markup has not been done in the authoring tool, Adobe Acrobat Pro can be used to provide the tags. See if
you need to modify converted headings or add new ones.
This example is shown in operation in the working example of creating bookmarks with Word 2007 .

Example 2: Converting a table of contents created with OpenOffice.org Writer 2.2 and creating bookmarks
for Adobe Reader 9 and Acrobat 9 Pro

This example is shown with OpenOffice.org Writer and Adobe Acrobat Pro and Reader. There are other software
tools that perform similar functions. See the list of other software tools in .

1. Create a table of contents at the beginning of the OpenOffice.org Writer document:
o0 Insert>Indexes and Tables... > Indexes and Tables > Insert Index/Table

2. Use File > Export as PDF... to convert the document to PDF, specifying Tagged PDF in the Options
dialog.

2 Untitled 1 - OpenOffice.org Writer

File Edit View [nset Format Table Tools Window Help

Foy f » - Ak c e - . - ~
(R = e w R P H-¢ D- @E-v #2EE8TQ O,
7. Contents 1 [#]  Adal > 1 |- IB ikl |E!{ Em Tt A-w-2- .
b [les e [ O © [B Cf s oGy
Insert Index/Table i
L
IndexfTable | Entries | Styles !Columns | Background | —
Type and title =
Title i’able of Contents
Table of Contents ;
MEADMG L . s -1 Type Table of Contents -
Hestma 1.1 1 -
ENTRY 1 ¥ Protected against manual changes
Hessma 12 1
Create index/table
HEADING 1 2 luate up to level -
THE E B¢ conkation e Srtolaplr THE &2 aser dbecbiye ity far Entire document fvaluate up to leve 10 =
HEADING 1.1 Create from
— THE ¥ D CONERTRON CHIPRE 11 THE B e €03y 5 04 Tk o cork Ve 4] Oytline
HEADING 12 Additional Styles
THE & e coneatiom chapier 1 2 THE keywoed I 3mai eaby.
| Index marks
[ | | | | ]
o | | | | | ]
Tatk 1:TE b bk |
.
0K Cancel | [ Help | [ Reser | Ereview
|

Figure 3 Image of the Insert Index/Table dialog in OpenOffice.org Writer.

The table-of-contents entries in the converted document will be linked to the headings in the document, and will
appear as PDF Bookmarks in the left-hand Navigation pane. The OpenOffice.org Table of Contents and
Bookmarks look the same as they appeared in Example 1.

This example is shown in operation in the working example of creating bookmarks with OpenOffice Writer.
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Example 3: Adding bookmarks using Adobe Acrobat 9 Pro after conversion

This example is shown with Adobe Acrobat Pro. There are other software tools that perform similar functions. See
the list of other software tools in .

After conversion to tagged PDF, you may decide to add bookmarks that were not automatically generated. Like
the converted bookmarks, tagged bookmarks use the underlying structural information in the document.

1. Inthe Bookmarks panel, choose the options menu, then choose New Bookmarks From Structure...
2. From the Structure Elements dialog, select the elements you want specified as tagged bookmarks.

The image below shows the Bookmarks options menu.

lu Bookmarks

| &
Mew Bookmark Ctrl+B

New Bookmarks from Structure...
Expand Current Bookmark
Collapse Top-Level Bookmarks

¥ Highlight Current Bookmark
Hide After Use

Text Size

Go to Bookmark

Print Page(s)

{er Selected Bookmark
elected Bookmark

Delete Bookmark(s)

Set Bookmark Destination

Rename Bookmark

Use Current Appearance as New Default
¥ Wrap Long Bookmarks

Properties..,

R s B s s o S

Figure 4 The Bookmarks options menu.

The next image shows the selection of links in the document for bookmarking.
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'u Bookmarks

v Structure Elements
Structure H
"H1 [>
H2 7 7 7 B ‘
I |-
P
=4
| Sect E
| Span i
Underline 5
b
=
!"""""""" TRy |
| selectall | | Clearau |
l OK Cancel .

(3]

Figure 5 The tagged elements that can be used for bookmarking, with ‘links’ selected.

The tagged bookmarks are nested under a new, untitled bookmark. Access the context menu for the new bookmark
and select the Rename option to rename the new bookmark, as shown in the following image.

=] Header One Header One
B EJ Header Two for List Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nunc sed velit in mi molestie feugiat eu et
= E] Header Three Text SBpEn, Vivamus su mi velir, 391 ameT [3cinia tormor, Asnean sollicitudin, metus vitae laorest ullamoorper,
vielit leo pretium mawris, nec ultrices lacus ligula at elit. In rutrum viverra aliquam. Cras dignissim, tellus

Bl Header Four i v .
U SAgiTs ﬂe“&rﬂefoque. porter risus dectum miulla, &u arnare nune nisl eget ll‘ua.

= .[I Another Header One
[I_l Another Header Two for Lict Header Two for List

I i Mulla @ justo ne< risus malesuada

=] Lnks
EIL WCAG2.0 *  WCAGY 0 Lorem ipsum dolor sit amet, consecietur adipiscng elit.

¢ Nulla sagittis raagna ot lacus adipicing vulpurate blandit libers hendrarit,

* Nullam 3 est &get iphum egesnas ristique

Header Three Text

Figure 6 The bookmarks for the hyperlink in the document.

This example is shown in operation in the working example of creating bookmarks with Acrobat Pro.
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@

Case eFiled successfully [E-Filing Number. C202400008 - WP(C)]
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CAVEAT FILING DISTRICT COURT

o

New case aggec
E-Fiing Number. C202200004 - Caveat
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g

Case efiled successfully [E-Filng Number C202200004 - Caveal]
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